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Unit 1 Learning Outcomes	
Students will know...
· how to organize data into graphs, charts and equations to represent motion.
· the perceived motion of an object depends on the position and motion of an observer.
· vectors describe and relate an object’s motion mathematically within its frame of reference.
· how to manipulate variables in an equation to represent their mathematical relationship.


Unit 1 Vocabulary
Vocabulary to review: 

	acceleration accuracy 
average 
axis 
delta ∆ 
dimensional analysis
	distance 
metric units
percent error precision 
qualitative data
	quantitative data
rate 
scale 
scientific notation 
SI system       
	significant figures slope 
speed 
variables 
velocity





Vocabulary new for mastery:

	average velocity
direct relationship
    (direct variation      
       used in algebra) displacement 
frame of reference

	free fall (g)
instantaneous velocity inverse relationship
   (inverse variation is       
      used in algebra) kinematics

	linear motion 
linear slope magnitude 
motion detector
negative acceleration

	photogate 
positive acceleration resultant 
scalar 
uniform motion vector
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Graph Matching
One of the most effective methods of describing motion is to plot graphs of position, velocity, and acceleration vs. time. From such a graphical representation, it is possible to determine in what direction an object is going, how fast it is moving, how far it traveled, and whether it is speeding up or slowing down. In this experiment, you will use a Motion Detector to determine this information by plotting a real time graph of your motion as you move across the classroom.

A qualitative analysis of the graphs of your motion will help you understand the concepts of kinematics.

OBJECTIVES
Analyze the motion of a student walking across the room.
Predict, sketch, and test position vs. time kinematics graphs.
Predict, sketch, and test velocity vs. time kinematics graphs.
MATERIALS
	




Matching Graphs	Page 4


LabQuest 
meter stick
Journal
masking tape
Motion Detector


PRELIMINARY QUESTIONS
1. Sketch the position vs. time graph for each of the following situations in your journal. Use a coordinate system with the origin at far left and positive distances increasing to the right.
a. An object at rest
b. An object moving in the positive direction (away from the origin) with a constant speed
c. An object moving in the negative direction (towards the origin) with a constant speed
d. An object that is accelerating in the positive direction, starting from rest
2. Sketch the velocity vs. time graph for each of the situations described above.

PROCEDURE
1. Find an open area at least 4 m long in front of a wall. Use short strips of masking tape on the floor to mark distances of 1 m, 2 m, and 3 m from the wall. You will be measuring distances from the Motion Detector in your hands to the wall.
2. If your Motion Detector has a switch, set it to Normal. 
[image: ]
3. Connect the Motion Detector to DIG 1 of LabQuest and choose New from the File menu. 
4. On the Meter screen, tap Length, then change the data-collection length to 10 seconds. Select OK.

Part l Preliminary Experiments
1. Open the hinge on the Motion Detector. When you collect data, hold the Motion Detector so the round, metal detector is always pointed directly at the wall. Sometimes you will have to walk backwards.
[image: ]
2. Monitor the position readings. Move back and forth and confirm that the values make sense.
3. Make a position vs time and velocity vs time graph of your motion when you walk away from the wall with a slow constant velocity. To do this, stand about 1 m from the wall and start data collection. Walk backward, slowly away from the wall after data collection begins. Record your graphs on in your journal.
4. Sketch what the graphs will look like if you walk faster. Check your prediction with the Motion Detector. Start data collection when you are ready to begin walking. 
5. Test your predictions in the Preliminary Questions section by walking in back and forth in front of the wall. If your predictions of graph shapes were incorrect, draw the correct shape over your prediction in a different color.


Part Il Position vs. Time Graph Matching
1. Choose Motion Match ► New Position Match from the Analyze menu to set up LabQuest for graph matching. A target graph will be displayed for you to match.
2. In your journal write down how you would walk to reproduce the target graph. Sketch a copy of the graph.
3. To test your prediction, choose a starting position. Start data collection, then walk in such a way that the graph of your motion matches the target graph on the screen.
4. If you were not successful, start data collection again when you are ready to begin walking. 
5. Repeat this process until your motion closely matches the graph on the screen. Correct your statement about you would walk to match the graph.
6. Perform a second graph match by again choosing Motion Match ► New Position Match from the Analyze menu. This will generate a new target graph for you to match.
7.  Perform a second graph match by again choosing Motion Match ► New Position Match from the Analyze menu. This will generate a new target graph for you to match.
8. Answer the Analysis questions for Part II before proceeding to Part III.
9. Answer the following questions in your journal:
a. Describe any changes you had to make to your original predictions.
b. Explain the significance of the slope of a position vs. time graph. Include a discussion of positive and negative slope.
c. What type of motion is occurring when the slope of a position vs. time graph is zero?
d. What type of motion is occurring when the slope of a position vs. time graph is constant?
e. What type of motion is occurring when the slope of a position vs. time graph is changing?


Part IIl Velocity vs. Time Graph Matching
1. LabQuest can also generate random target velocity graphs for you to match. Choose Motion Match ► New Velocity Match from the Analyze menu to view a velocity target graph.
2. Write down how you would walk to produce this target graph. Sketch or print a copy of the graph.
3. To test your prediction, choose a starting position and stand at that point. Have your partner start data collection, then walk in such a way that the graph of your motion matches the target graph on the screen. It will be more difficult to match the velocity graph than it was for the position graph. 
4. If you were not successful, have your partner start data collection when you are ready to start walking. Repeat this process until your motion closely matches the graph on the screen. Print or sketch the graph with your best attempt.
5. Perform a second and third velocity graph match by choosing Motion Match ► New Velocity Match from the Analyze menu. This will generate a new target velocity graph for you to match.
6. Remove the masking tape strips from the floor.
7. Answer the following question in your journal:
a. Describe how you walked for each of the graphs that you matched.
b. What type of motion is occurring when the slope of a velocity vs. time graph is zero?
c. What type of motion is occurring when the slope of a velocity vs. time graph is not zero?


EXTENSIONS
1. Create a graph-matching challenge. Sketch a position vs. time graph on a piece of paper and challenge another student in the class to match your graph. Have the other student challenge you in the same way.
2. Create a velocity vs. time challenge in a similar manner.






Name_____________________________________________Date__________________Per___
Graph Matching Lab Results
Preliminary Questions: Write description and sketch graph.
1a.                                                                                         2a.
                                                                                               									




1b.                                                                                              2b. 									




1c,                                                                                        2c.
                                                                                               									




1d.                                                                                        2d.
                                                                                               									



Part 1.  Preliminary Experiments
3)




4)




5)  use a different color on the graphs in the preliminary questions

Part II.  Position vs. Time Graph Matching
2)



5)



6)



9a.



9b.



9c.



9d.



9e.



Part III.  Velocity vs. Time Graph Matching
Try this.  These graphs may be more difficult to match than the position vs. time graphs.
7b.


7c.

Moving Man- Distance vs. Time Graphs
[image: ]
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Project Motion: How Do You Move?

Procedure: Each group will create either a poster, a video, or a skit describing a person’s motion in a school appropriate situation of their choosing.  All presentations must include 
A) a story describing how someone is moving
· It must have examples of positive velocity, negative velocity, acceleration, and your person being at rest 
B) a Position vs. Time graph that describes your story
C) a Velocity vs. Time graph that describes your story

Group Roles: Each group must have a Storyteller, an Artist, and a Grapher.
· The Storyteller will explain the group’s story/graph to the class on presentation day
· The Artist will help create the poster/video/story. A 3 person group must also have:
· A Grapher who will be responsible for drawing the two graphs for the project
· Any 2-person groups will split the graphing duties   
Students may select up to two group members from within their own class period. Group roles will count for 50% of your grade. Please see the attached rubric for a detailed breakdown of the grading.

Presentation Day:  Each group will present their poster, video, or skit the to their class period. Please see the class calendar on my website for the presentation date. 


Project Motion: How Do You Move? Rubric
	
	Overall Presentation
	Storyteller 
	Artist 
	Grapher

	4
	Contains both graphs, correctly drawn with slopes properly calculated and used to drawn the VvT graph.
Tells a clear story that is properly matched at all points to your PvT and VvT graphs. 
Has clear examples for each of the four types of motion. 
Uses physics vocab for all discussion/writing. 
	Clearly and specifically describes all of the 4 types of motion and links them to parts in the skit/video/etc. 
Identifies the portions of both graphs which match specific pictures/parts of the skit/etc
Correctly uses physics vocab for all of the relevant terms. 
Is able to answer all questions 
	Clear, correct examples are provided for each of the four types of motion. 
The poster/skit/etc… is arranged in a clear, logical order showing how motion changes. 
Both graphs are included in the presentation and are large enough to read.


	Both graphs have proper labels for everything. 
Both graphs have their lines drawn correctly.  
The slopes of the lines on the PvT graph are used to correctly create the VvT graph. 


	3
	Contains both graphs, with minor mistakes in drawing the lines/ labeling/ calculating the lines’ slopes correctly/correctly transferring information on PvT graph to Vvt 
Tells a story that is, overall, properly matched, at most points, to your PvT and VvT graphs. 
Has correct examples for 3 of the 4 types of motion. 
Uses physics vocab for most. discussion/writing.
	Correctly describes/identifies 3 of the 4  types of motion  in the skit/video/etc, and/or correctly identifies 3 of the 4 portions of both graphs which match specific pictures/parts of the skit/etc
Correctly uses physics vocab for most of the relevant terms. 
Is able to answer most questions.
	Correct examples are provided for 3  of the 4 types of motion. 
The poster/skit/etc… is arranged in a way that requires a good bit of elaboration to make sense of it. 
Both graphs are included in the presentation, but are not large enough to read.
	Both graphs are included with most of the correct labels. 
Both graphs have most of their lines drawn correctly.  
The slopes of the lines on the  PvT graph are used to create an VvT graph, but there are mistakes. 

	2
	Contains both graphs, with significant  mistakes in drawing the lines/ labeling/ calculating the lines’ slopes correctly/correctly transferring information on PvT graph to VvT 
Tells a story that is only partially properly matched to your PvT and VvT graphs. 
Has correct examples for 2 of the 4 types of motion. 
Uses physics vocab for only a little discussion/writing.
	Correctly describes/identifies 2 of the 4  types of motion  in the skit/video/etc, and/or correctly identifies 2 of the 4 portions of both graphs which match specific pictures/parts of the skit/etc
Correctly uses physics vocab only some of the relevant terms. 
Is able to answer only some of questions.
	Correct examples are provided for 2 of the 4 types of motion. 
The poster/skit/etc… is arranged in a way that requires extreme elaboration to make sense of it. 
Only 1 of 2 graphs are included, and it is not large enough to read.
	Both graphs are included with some of the correct labels. 
Both graphs have some of their lines drawn correctly.  
The slopes of the lines on the  PvT graph are used to create an VvT graph, but there are serious mistakes.

	1
	Contains both graphs, with extreme errors in drawing the lines/ labeling/ calculating the lines’ slopes correctly/correctly transferring information on PvT graph to VvT , or is missing one or both graphs
Tells a story that is almost never properly matched to your PvT and VvT graphs. 
Has correct examples for 1 or 0 of the four types of motion. 
Uses no physics vocab.
	Correctly describes/identifies 1 or fewer of the 4  types of motion  in the skit/video/etc, and/or correctly identifies 1 or fewer of  the 4 portions of both graphs which match specific pictures/parts of the skit/etc
Uses no physics vocab, or uses it incorrectly. 
Is not able to answer questions.
	Correct examples are provided for 1 or fewer of the 4 types of motion. 
The poster/skit/etc… is arranged in a way that makes no sense, even with the Storyteller’s elaboration. 
No graphs are included.
	One or more graphs are missing and/or one or more graphs is completely lacking correct labels. 
Neither graph has any of its lines drawn properly.  
The slopes of the lines on the PvT graph are not used to create an VvT graph and/or the translation of PvT to an VvT graph is completely wrong. 









Motion Graphs
1.  Describe the motion.
2. Sketch the matching velocity vs. time graph.
Position vs. Time Graphs				Velocity vs. Time Graphs

[image: Position vs time constant v]

[image: position vs time constant v and accleration]

[image: x vs t negative accel from rest]

[image: x vs t positive accel w neg initial velocity]
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[image: Image result for motion graph summary]
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Complete the table by determining the magnitude and direction of the relative velocity of each "object" depicted in the diagram below by comparing each one's motion to the frame of reference listed in the first column of the table.
[image: http://dev.physicslab.org/img/4411fe95-079e-42c2-a86f-8ec2366d891d.gif]
The current values in the table are from the frame of reference of the Hitch Hiker.
[image: ]


Formulas Chart
	1-Dimensional Motion
	
	Other

	Velocity
[image: ]
[image: ]
	Acceleration
	
	Gravity
g = 9.8 m/s2

Pythagorean
a2 + b2 = c2

	
	[image: ][image: ]
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Quantity Chart
	Quantity
	Symbol in Formula
	Description/ definition
	Unit
	Unit Symbol

	distance
	

	
	
	

	displacement
	

	
	
	

	speed
	

	
	
	

	velocity
	

	
	
	

	acceleration
	

	
	
	

	acceleration due to gravity
	
	
	
	

	time
	

	
	
	



Name:                                                                          Period: 

One-Dimensional Motion Practice Problems
[image: ]1) A bird that is traveling at 5 m/s, accelerates at 2.5 m/s2 for 8 seconds. How far did the bird travel during those 8 seconds? 


 









2) A race car that is traveling at 45 m/s, accelerates at 9 m/s2 for 12 seconds. How far did the car travel during those 12 seconds? 
[image: ]









3) A lion is chasing a zebra at 4 m/s. The lion accelerates at a rate of 1.3 m/s2 for 23 seconds. How far did the lion travel during those 23 seconds? 
[image: ]









4) A bus that is traveling at 15 m/s accelerates at a rate of 3.3 m/s2 for 6 seconds. How far did the bus travel during those 6 seconds? 
[image: ]






5) A fighter jet is traveling at 300 m/s, and accelerates at 30 m/s2 for 21 seconds. How far did the jet travel during those 21 seconds? 
[image: ]









[image: ]6)  A bicycle that is traveling at 2 m/s accelerates at 1.2 m/s2 for 13 seconds. How far did the bike travel during those 13 seconds? 










[image: ]7) A car is initially traveling at a speed of 32 meters per second. Its breaks are applied over a distance of 45 meters, causing it to accelerate to a speed of 12 meters per second. What is the magnitude of the car’s acceleration? 










[image: ]8) An elephant is initially traveling at a speed of 2 meters per second. It sees a mouse, and runs away for 45 meters, causing it to accelerate to a speed of 12 meters per second. What is the elephant’s acceleration? 










[image: ]9) A car is initially traveling at a speed of 22 meters per second. Its driver stomps on the gas pedal and keeps it pressed down to the floor, over a distance of 115 meters, causing it to accelerate to a speed of 35 meters per second. What is car’s acceleration? 










10) A cat is initially traveling at a speed of 1.5 m/s.  It sees a mouse, and chases it for 12 meters, reaching a top speed of 12 m/s.  What is the cat’s acceleration? 
[image: ]








[image: ]11)  A dog is at rest, and sees the cat from problem 10.  The dog chases the cat back to the cat’s home, 45 meters away.   The dog’s top speed is while chasing the cat is 9 m/s, towards the cat’s home. What is the dog’s acceleration? 










[image: ]12) The Flash is running at a speed of 500 m/s. He slips on a banana peel, and then tumbles over 275 meters of sandpaper, causing the Flash to accelerate to a speed of 2 m/s. What is the Flash’s acceleration? 









[image: ]13) A flying fish is swimming at 3 m/s, and leaps out of the water, traveling 11 m/s.  If it took the fish .4 seconds to jump out of the water, what was the fish’s acceleration? 










14) An Olympic skier is competing in the super giant slalom, and reaches a speed of 40 m/s at the bottom of the hill.  In 4.2 seconds, he comes to rest. What is the skier’s acceleration? 
[image: ]








[image: ]15) Dorothy is walking through the forest at a rate of 1.3 m/s, when she is captured by a flying monkey. The monkey flies off at 15.5 m/s. It took the monkey 2 seconds to reach its top speed. What was the flying monkey’s acceleration? 




















[image: ]16) The driver of a sports car is driving at 5 m/s when he takes the on-ramp for the toll road.  After 11 seconds, his velocity is 37 m/s.  What is the driver’s acceleration? 










17)  A Great White shark is chasing a seal through the water at 15 m/s, and accelerates to a speed of 26 m/s in 2 seconds, before eating the seal.  What is the shark’s acceleration? 
[image: ]









[image: ]18) A giant squid then sees the shark from problem 17, and swims up to the surface at 3 m/s, before grabbing the shark, and dragging it down into the deep at a speed of 40 m/s.  It takes the squid 16 seconds to reach the bottom of the ocean. What was the squid’s acceleration? 

















Example 1 - Vectors
[image: 4 vectors]
The displacement vector A has direction 'up' and a magnitude of 4 cm.
Vector B has the same direction as A, and has half the magnitude (2 cm).
Vector C has the same magnitude as A (4 units), but it has different direction.
Vector D is equivalent to vector A. It has the same magnitude and the same direction. It doesn't matter that A is in a different position to D - they are still considered to be equivalent vectors because they have the same magnitude and same direction. We can write:
A = D
Note: We cannot write A = C because even though A and C have the same magnitude (4 cm), they have different direction. They are not equivalent.

Practice Problems.  Find the magnitude and direction.  Draw the vectors to scale and label the vectors and the resultant.

1.  A + B		2.  A + C	3.  A + D	4.  B + C	5. B + D	6. A + B + C













[bookmark: _GoBack]Toy Car Lab
Investigating:
1.  What is the effect of time on the distance traveled by the toy car?
2. Is velocity constant for each car?

Brainstorm
1. What is the independent variable?  What should be the increments? How many times?
2. What is the dependent variable?  (This is what’s measured!)

Data Table and Graph Build
Results
· Develop a procedure, grab a car, collect – analyze – graph data.
· Please only take one type of car at once. When you are finished, return the car so another group can use it.
· Turn the car off when not being used to conserve batteries. 










Toy Car Lab
Purpose:
The purpose of this lab is to determine the effect of time on the distance traveled    by a toy car.

Materials:  (list the materials used)
· 
· 
Procedure:  (number the steps used to perform the lab)
1.
2.
3.
4.

Data:
	TRIAL
(car 1)
	

	
	

	1
	

	
	

	2
	

	
	

	3
	

	
	



	TRIAL
(car 2)
	

	
	

	1
	

	
	

	2
	

	
	

	3
	

	
	




Graph: (remember to title and label axes with units)


	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	






Conclusion Questions:
1. What is the effect of time on the distance traveled by the toy car?


2. Is velocity constant for each car?





Name_______________________________________________Date______________________Per___
Free-Fall Lab
 
Scenario:
 
A group of young enterprising students at Cedar Ridge HS used three different heights around the campus and timed how long it took a tennis ball to fall to the ground.
 
Procedure: (write your procedure below)
1.  
  
2.   

3.    


Data:
	Height (m)
	Trial 1 (s)
	Trial 2 (s)
	Trial 3 (s)
	Average (s)
	g (m/s2)

	 
	 
	 
	 
	 
	 

	 
	 
	 
	 
	 
	 

	 
	 
	 
	 
	 
	 


 

Conclusion:
1. According to the data, what is the best known value for baby g here at CRHS?




2. Why does this value not match the accepted 9.8 m/s2?




3. Is there a relationship between the height used and how accurate baby g was found to be?




4. Where there any data points that should have been thrown out? Why?







Name ____________________________________Date___________________Period ___

Free Fall Problems Worksheet
For the following problems, show all work and write the answers in the blank.

1. An object falls from a high building. Ignoring air resistance, what will its velocity be after 6 seconds of falling?                                                                  




________________

2. An object falls from a high building and hits the ground in 9.0 seconds. Ignoring air resistance, what is the distance that it fell?




________________

3. During a tornado in 2008 the Peachtree Plaza Westin Hotel in downtown Atlanta suffered damage.  Suppose a piece of glass dropped near the top of the hotel falling 215 meters.

A. Ignoring air resistance, how long would it take the piece of glass to hit the ground?




________________

B. Ignoring air resistance, what will the velocity of the piece of glass be when it strikes the
ground?



________________

4. An object falls from the Transco Tower in Houston and takes 15 seconds to reach the ground.

A. What is its velocity at impact if air resistance is ignored?




________________

B. How tall is the building?


________________



C. What is its acceleration at the 2nd second? 


_______________


D. What is its acceleration at the 5th second? 




_______________

E. If the Transco Tower were actually 3,000 meters tall, how long would an object take to free-fall off of the top of the building? (ignoring air resistance)




________________


5. Wil-E-Coyote drops a bowling ball off a cliff to try to catch the Roadrunner. The cliff is 132m high.

A. How long does it take the ball to fall to the ground?



_________________

B. What is its impact velocity?



_________________

C. How far does it fall in the first 3.0 seconds?



_________________

D. How fast is it going at the end of 3.0 seconds?



_________________

E. How long would it take the same ball to fall if the cliff was on the moon?
    (g = 1.63 m/s2)?



_________________

6. You drop your cell phone while in the bathroom in front of the mirror while the water is running in the sink below. If you are 0.45 meters above the sink, how long do you have before your cell phone is a gonner.

_________________

One Dimensional Motion Study Guide

Speed and Velocity
_____ Calculate speed or velocity when given distance and time.
_____Calculate distance when given speed or velocity and time.

Vectors
_____Add two vectors that go in the same direction.
_____Add two vectors that go in opposite directions.
_____Add two vectors that are perpendicular.
_____Add more than two vectors and resolve the resultant vector.
_____Understand the difference between distance and displacement.
_____Understand the difference between speed and velocity.

Motion Graphs
_____Interpret an object moving at constant positive velocity off of a position time graph.
_____Interpret an object moving at constant negative velocity off of a position time graph.
_____Interpret an object at rest off of a position time graph.
_____Interpret an object speeding up (accelerating) off of a position time graph.
_____Interpret an object slowing down (accelerating) off of a position time graph.
_____Interpret an object at rest off of a velocity time graph.
_____Interpret an object moving at constant positive velocity off of a velocity time graph.
_____Interpret an object moving at constant negative velocity off of a velocity time graph.
_____Interpret an object with positive acceleration off of a velocity time graph.
_____Interpret an object with negative acceleration off of a velocity time graph.
_____Draw and identify the distance time graph of an object experiencing free-fall.
_____Draw and identify the speed time graph of an object experiencing free-fall.


Horizontal Acceleration
_____Identify hidden variables such as from rest or to a stop.
_____Identify the variables of distance, time, initial speed/velocity, final speed/velocity and acceleration in word problems.
_____Recognize acceleration when given data tables of time and displacement.
_____Solve for final speed/velocity when given initial speed/velocity, time and acceleration.
_____Solve for distance when given acceleration, initial and final speed/velocity.
_____Solve for distance when given acceleration, initial and final speed/velocity.
_____Solve for acceleration when give distance, initial and final speed/velocity.
_____Solve for acceleration when give time, initial and final speed/velocity.
_____Solve for distance when give time, initial speed/velocity and acceleration.

Vertical Acceleration
_____Identify hidden variables such as initial velocity when dropped, velocity at the apex, and acceleration due to gravity.
_____Identify the variables of distance, time, initial speed/velocity, final speed/velocity and acceleration in word problems.
_____Understand why acceleration due to gravity is negative.
_____Understand why displacement of a falling object is negative.
_____Solve for acceleration due to gravity when given displacement, initial and final speed/velocity.
_____Solve for the height of a dropped object when given time.
_____Solve for final velocity of a dropped object when given time.












If found, please return to room B118
~ 9 ~
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Background — Graphs are not just an evil thing your teacher makes you create, they are a means of
communication. Tn this activity you will learn to speak and read “graph”.
Learning Goals — The students will:
* Develop a general knowledge of distance time graphs.
© What a graph of a person standing still would look like
© What a graph of a person moving away from an observer would look like.
© What a graph of a person moving owards an observer would look like.
o How differences in speed appear on the graph
Procedure — do the following activity using this web site =

Then click on “The Moving Man™

1. Getting started. After “Moving Man™ is open leave the position
graph open but close all of the other graphs, velocity and
acceleration. Your screen should look like sereen 1.

2. Making observations. By cither clicking on the man or the slider
cause the man to move back and forth and observe what shows up on
the graph. Using the axes provided below make a sketch of the
‘graph that is produced by cach action described next to each axis. Screen1
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A man moving from Om to 10m at a slow
steady pace.

A man moving from Om to 10m at a fast
pace.

A man standing still at 4m.
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Apply what you learned. Look at the graph below and for the different parts of the graph that are
‘marked write a statement about what is happening. Be sure to include the direction of motion and the
speed of motion.

. 00m =

Part | Description of direction and speed

| ml ool ® >
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Moving Man - Velocity vs. Time Graphs

Student Pages

Background — Remember graphs are not just an evil thing your teacher makes you create, they are a means
of communication Graphs are a way of communicating by using pictures and since a picture is worth a thousand
words knowing how to make and interpret graphs will save you a lot of writing.
Learning Goals — The students will:
o Develop a general knowledge of “Velocity vs. Time™ graphs and
“Distance vs. Time" graphs
© What graphs of a person standing still would look like 2
© What graphs of a person moving away from an observer at
a constant speed would look like.
© What graphs of a person moving towards an observer at a
constant speed would look like.
o How differences in speed appear on the graphs

Procedure — Do the following activity using this web site — Screen 1
it s colorado e physics phet imultionsbase bl | Sereenl |

Then click on ~The Moving Man™
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1. Getting started. After “The Moving Man™ is open leave the position graph and the velocity graph

open but close the aceeleration graph. Your sereen should look like sereen 1.

2. Making observations. By cither clicking on the man or the slider cause the man to move back and

forth and observe what shows up on the graphs. Using the axis provided below make sketches of
Distance vs. Time and Velocity vs. Time graphs for the actions described next to cach axis.
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Moving Man - Velocity vs. Time Graphs
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Apply what you learned. Look at the Distance vs. Time graph below and for the different parts of the
graph that are marked by the dotted lines make the corresponding Velocity vs. Time graph directly
Delow each part.
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Position (m)

Name: Date:

Graphical Analysis of Motion
Part 1: Concepts:

1. The graph below shows the position vs time for an object in motion. Give a description of what
the object is doing during cach of the intervals listed in the table below:

Region | Start End Description of Motion
Time (s) | Time (s)

Time (s)
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Velocity (m/s)

Time (s)

. The graph below shows the velocity vs time for an object in motion. Give a description of what
the object is doing during cach of the intervals listed in the table below

Region

Time (s)

End
Time (s)

Description of Motion
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iph below is a graph of position versus time. Use this graph to create a graph of

vs. time.
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Name:

Part 2: Practice Problems:

4. One of the best runners ever from the state of New Jersey was a man called Carl Lewis. In 1991
he set the record for the 100-m run with a time of 9.86 seconds. To get a better idea of his
performance in this event his times to run each 10-meter section of the race were released o the
public. Below is a chart that lists these times for each 10-meter interval. Use these charts to plot
his position as a function of time. For an added challenge also make a graph of his veloeity as a
function of time.

Date:

Interval Time for Interval (s)| Position (m) | Total Time (s)| Velocity (m/s)
1 1.88
2 1.08
3 0.92
4 0.89
5 0.84
3 084
7 0.84
8 0.83
9 0.85
10 0.89
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Motion Graph Summary

Type of Position vs. Time graph Velocity vs. Time graph
motion Direction Direction
(+) away from origin (~) toward origin (+) away from origin (-) toward origin
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Motion graph summary

On a displacement-time graph ..

«  slope equals velocity.

« the "y intercept equals
the initial displacement.

« straight lines imply constant velocity.

« curved lines imply acceleration.

« an object
undergoing constant acceleration traces
a portion of a parabola.

« average velocity is the slope of the
straight line connecting the endpoints
of acurve.

« instantaneous velocity is the slope of
the line tangent to a curve at any
point.

« positive slope implies motion in the
positive direction.

« negative slope implies motion in the
negative direction.

« zero slope implies a state of rest.

« The area under the curve is
meaningless

3

o

displacergent (m)

displacerent (m)

5

time (5) 10
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On a velocity(speed)-time graph

«  slope equals acceleration.

« the'y" intercept equals
the initial velocity.

« straight lines
imply uniform acceleration.

« curved lines imply non-
uniform acceleration.

« an object
undergoing constant acceleration traces
a straight fine.

« average acceleration is the slope of the
straight line connecting the endpoints,
of acurve.

« instantaneous acceleration is the slope
of the line tangent to a curve at any
point.

« positive slope implies an increase in
velocity in the positive direction.

« negative slope implies an increase in
velocity in the negative direction.

« zero slope implies motion
with constant velocity.

« the area under the curve equals
the change in displacement.

5 time(s) 10
v=90mis
v=60mis
v=30ms

5 time(s) 10
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